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Why are we here?

... and, why are we talking about packet?

Purpose
+ City... provides services; promotes the common good
« EMS... = Prepares for disasters
= responds to minimize loss of life and property
= speeds the recovery
Needs
« EMS... * needs information... what’s going on out there?
= work with recovery partners and service providers
Capabilities

* What we bring...
= Volunteerism!... An interest to help out
= Communications
= Structure
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Governmental bodies, civic groups and clubs provide services of various types to
their members. All these groups need information in order to make decisions and
respond effectively. Depending on the situation, the need for information may cover
only a small area (a building or a park), or perhaps a large are (such as a city or
county).

What do we bring? First, we love to help out — we’re volunteers! But we bring a
unique ability — the ability to communicate effectively over a wide area. Se also
bring a lot of structure to the table — we typically like to enforce the way messages
are defined and handled.



Why are we here?

... and, why are we talking about packet?

Capabilities... communications
* Frequency agility
+ Different modes... voice, dafta, video
« Bandwidth
* Independence from comymercial services

Simple Messages Complex Messages
Mode Voice Packet
Messages Short messages Lists, instructions, details
Delivery Immediate Store & forward; mail drop
Equipment Radio Radio + TNC+ PC + SW + BBS
Complexity Short learning curve  Many commands
)
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We are communicators. But beyond that, we have more than just the ability to
communicate and get a message from point A to point B. This slide lists some of the
capabilities that we bring to the table, including the ability to move information
either via voice, or via digital means.

When comparing voice versus digital, there are some stand-out differences as
shown by the chart. VVoice is easy — push the button and talk. But digital, and its
form that we use known as packet radio, is known for being harder to implement
and requires more equipment. The plus of packet is that you can transmit a lot more

information in a shorter time. And this data can be formatted, such as lists or
spreadsheets.



Why are we here?

... and, why are we talking about packet?

Mapping Capabilities to Needs

+ City OES... message handling with field sites, etc.

» Santa Clara County OES... EOC-to-EOC message handling
* RIMS backup (PACRIMS)
 City Scan / Flash Report
» County Logistics Request Form

» Emergency Volunteer Centers
CAPABILITIES help fulfill NEEDS, that support PURPOSE
Is Packet a capability that could address other needs?
3

The reason we are here discussing packet is because there is an ever-growing
demand for our resources and capabilities. More and more public agencies are
wanting to use ham radio as their backup method of communications in case of
disaster. The other reason that we are here is just the sheer volume of data that will
need to be communicated from one site to another. As the previous slide
demonstrates, voice is good for short messages. Digital (packet) is much better for
longer messages.



Why are we here, really?

R

To dispel silly

myths about
packet radio!

N
£ =
\r
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Buy why are we really here?

When originally suggesting this training session, I had very little knowledge of
packet. But | had heard stores, war stories about packet. There were explanations of
why packet was no good, why it was so hard and cumbersome to use. The general
feeling was that this (packet) is a hornet’s nest and it’s the last place you want to
venture into.

To prepare for this class, | had to jump in with both feet. | purchased a Kantronics
KPC3+ TNC and spent 3 days trying to figure out how to build the cable that goes
between the radio and the TNC (I didn’t want to mess anything up). The manual is
less than great. So as | progressed through this, I was thinking “maybe they’re
right...”.

But it turns out that a lot of the horror stories appear (to me) to be myths. Nothing
more than myths. So in order to dispel these myths, I’ve asked the great myth-
dispeler of all, the Travelocity Gnome, to help us through this.



Myth #1
Setting up a packet station takes lots of time
and way too many cables and connectors.

.

Rubbish!

It's much easier than looking
for a needle. It takes only 3
boxes and two cables! Just
take a look!
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First myth: too much time, too many cables, too much work.

As our friend says, rubbish!



Packet — A Quick Overview

-

.
+.
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Granted, the initial part was tough, but I’m no techie — I’m a computer guy.
Soldering cables and getting the right capacitor at the right place took some time to
figure out. The other cable is the one between the TNC and the computer. A few
minutes at Fry’s and | was set. | walked out with a USB-to-serial adaptor and a 9-to-
25 pin cable.

This is as hard as it got. | plugged everything in, fired up the terminal emulator and
was able to talk to the TNC the first time. | was also able to contact the packet bbs
in Sunnyvale. Success! So the hardest part was mechanical.

This is a typical packet environment, and shows the flow from one node to another.
Notice the bbs/bulletin board in the middle by the big antenna. This is where
messages are stored for retrieval. This is just like the old post office with mail slots.



Setting the Volume

Setting the Correct Volume is easy
as...

1. Turnon TNC
2. Turn on radio to lowest

volume setting. Turn squelch
setting to lowest setting.

3. Turn up volume until “receive”
light on TNC lights up. Go just a
little bit more.

4. Turn up Squelch until light
goes back out.

!
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The one thing that is a “watch out for” is setting the volume. This is another great
myth — if you don’t have it set right your station won’t work. | found this not to be
true. Follow these simple instructions and you will be on your way. Another myth
down the tubes.



Myth #2
Sending messages via packet is difficult and
requires learning all kinds of silly commands

=

P.ﬁ‘.ﬂ, 1 == .- = L‘ -

ll Nonsense!

If you can put on a set of
headphones and push a
button to talk, you will find
this easy! Just use Outpost!
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Myth number 2: You have to learn all these funny TNC commands, then a
bunch of bulletin board commands and then remember when to use which set.

I’Il almost give this one to you. Granted, if you want to be a “Packet Purist”,
then you need to do this at some point. Cheat-sheets help.

But we aren’t here to be Packet Purists. We are here to do what we do best —
communicate. And to help us the County has standardized on a software
packaged called Outpost. In the next few slides, we will see how Outpost greatly
simplifies the environment for us, and thereby increasing our productivity.



Overview

What is Outpost?
* A Windows-based packet messaging client

» Supports ARES, RACES, and other amateur radio emergency response
teams and their need to pass digital traffic

» Helps automate the packet message handling environment
* Manages all message handling between you and your BBS
 Lets you read, delete, create, reply to, or forward messages back to the BBS

Outpost is a software layer that provides a nice user interface to
the complex world of packet operations, TNC usage and BBS
commands
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What is Outpost? Generally, outpost is just a piece of software that hides the
complexity of the TNC commands and the BBS commands. It manages the
communications to these devices as well as managing the messages that we send
and receive.

As a comparison, many of us use e-mail which uses a protocol called SMTP.
Did you know that SMTP has about 15 commands, and those 15 commands can
generate about 25 responses? Do you know those commands and responses?
Probably not. Most of us use an e-mail client like Outlook, or whatever e-mail
package is provided to us by our network provider. The e-mail client that we use
performs the same function that Outpost does — it hides the complexity of SMTP
from us. None of us would think about learning all of the SMTP commands. So
packet should be thought of in the same light — there isn’t a need to learn all of
the TNC and BBS commands — let Outpost do it for us.
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Overview

Why use Outpost?

» Leverages the existing packet hardware, network, and BBS infrastructure
» Compatible with many existing BBSs and TNC PBBSs
» Uses your existing TNC and packet radio equipment
» Only a packet client (end-user) change is required
» Hides the complexity of the packet operating environment
« Similar look and feel to contemporary email programs
« Shorter learning curve for packet operations
« Allows users to... “focus on the message, not the medium”
* Implements most local emergency management policies for digital
communications

« Still under active development based on user requests and on-going
alignment with the Outpost mission.
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The key point here is that since Outpost hides the complexity of sending and
receiving the message, we can focus on the message itself and not worry about
packet or the commands necessary to get the work done.
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Overview

General Outpost Features

* Message Management
» Multiple message folders
» Supports the three primary message types: Private, NTS, and Bulletins
» Text Formatting in a free-form message window
* NTS Message Maker with automated ARL message support
* On-line report builder using report templates
« Supports Urgent message, Delivery and Read Receipts

» Send/Receive Session Management
 Supports Serial, AGWPE, and Telnet interfacing to a BBS
» Automatically controls the sequence for initializing the selected interface, connecting to,
and sending messages to and retrieving messages from the BBS

» Configurations and Setups
* BBS, TNC, and Interfaces — manages a list of BBSs & Interfaces
» Message Retrieval — choose the message types ti be retrieved
» Send/Receive automation — 3 ways for automatically initiating BBS sessions
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e This is an overview of the capabilities provided by outpost. This presentation
does not cover a lot of these, such as NTS, online report builder and other
interfaces such as AGWPE. This presentation will focus on the capabilities that
we need to understand in order to be productive in an emergency situation.



Topics

* Features

» Creating Messages

* A Typical Session

* Limitations and Constraints
* Questions

13 Outpost Packet Message Manager 2.1.2
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The following slides discuss these points
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Features

B it post 10 Message Manage ==l
Fle Ede Sehp Tock Adtiond Help &
Message management 5 I 5| I W335
e Familiar ema”_app look and feel
ype | Fe ] T o . Date/Ti e
* Separate folders for message _ LR A S S
storage I e
: T WP NS KD AT NEWN Rameirg.. Moo ]
. E:Ieare(rj megsage |dent|f|cat|§)n I N rEE: umasien sws. o e
unread=BOLD, urgent=Re
* Follows a formal message
workflow
* Manage BBS and interface
Setups Dltems. ¥ Total | Station ID: KNGPE = THC: KPC-D - BECS: KISMB-2 |mmno 158

» Additional settings to control
how Outpost behaves

4
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This is the main menu that we see in Outpost. It is similar to other e-mail clients.
But let’s look at the various components of this screen.



A Closer Look

Outpost Packet Message Manager
File Edit Setup Tools Actions Help

= oper| ekt pre] |
Fouder List [ |n Tray
e U | Type [ From [To | BBS | Subject | Date/Time [ sie|
¢ B AABWK  ALL K6FB-2  BMHA Bicycle Mabile Hams of __ 11/28/9518:_. 399
- - B AABWK  ALL K6FB-2  Net Preamble 03/18/9321: . 3660
B AAGWK  ALL KEFB-2  >>> how 10 use the node and/or  03/18/9321:... 846
Ol Tray B AABWK AL KEFB-Z  Welcome 03/18/93 21.20 1035
B KNBPE  ALLUSR KBFB-2  Cuperlino ARES/RACES 11/04/06 17-... 246
B BABWK AL KEFE2  KEFE website, breakfast, net 11/04/05 18:53 261
B KEGBBCW  ALL KEFE-2  Packet Tutorial UL 05/31/00 1326 17
B GNCEOC  SCCEOC  WEXSC  SNCEOC operafional 07/22/06 14:52 363
B SNCEOC SCCEOC  WEXSC  dil01-2106 01/21/07 1606 467
B SHYEOC ALLEDC  WEXSC1  Request to submi 2005 SET data 10/17/06 2348 1836
CUPEOC LOSED.. WEBXSC-1 Welcome to outpost 03/20/07 14 321
B LOSEOC AL WENSC] TestBulletin from Las Altos Q3720007 14:21 243

Deleted

12 Iterms, 20 T@'Statlnr\ ID: NBJRC - Tactieal Call: LOSEOC - TNC: KPC-3 - BBS: WEXSCA |00:00:00 131751 |

e ——— ——— -
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I like to read the screen from the bottom-up. At the bottom is a status line that
shows our connection information. In here we will see our call sign, the TNC that
we are using, the BBS that we are using, and if needed, our tactical call sign (used
in Santa Clara County).



Outpost Packet Message Manager
File /it Setup Tools Actions Help
e open| Delete | print| |
e U [ Type [From [ Ta [ BBS | Subject | Date/Time [ siee]
i B AABWK  ALL K6FB-2  BMHA Bicycle Mabile Hams of __ 11/28/9518:_. 399
B AABWK  ALL KEFB-2  Net Preamble 03/18/9321:. 3660
B AABWK  ALL KEFB-2  >>> how to use the node and/or  03/18/9321:... 846
Ot Tray B AABWK AL KEFB2  Welcome 03/18/33 21:20 1035
B KNBPE  ALLUSR KBFB-2  Cupertino ARES/RACES 11040617 246
B AMBWK AL KEFE2  KEFE website, breakfast, net 11/04/05 18:53 261
B KEEBCW  ALL KEFB-2  Packet Tutorial UAL 05/31/00 1328 173
Sent B GSNCEOC  SCCEOC  WEXSC  SNCEQCA operational 07/22/06 14:52 63
Msgs B SNCEOC  SCCEOC  WEXSCA  dil 012106 01721407 16:06 467
B SNYEOC  ALLEDC  WEXSC1  Requesttosubmit 2005 SET data 10/17/06 23:48 1836
CUPEOC LOSED... WEXSC1 Welcome to outpost 03/20/07 14:... 321
Archive B LOSEOC AL WENSC Test Bulletin from Los Alos 03/20407 14:21 243
Diaft
Msg
Deleted
Msg
12 Iterns, 20 Totsl | Station ID: NGJAC. - Tactiesl Calt LOSENE - THE: KPC:3 - BRS: WRMEC om0 131751
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The left side of the screen is a navigation menu bar. These are the different areas, or
“folder” if you like, that are available in Outpost. When you click on one, that
folder is opened and the contents are displayed. The Current, or “open” folder is
shown by the dashes around the inside of the box (look at “In Tray” for an
example). The folder name is also displayed above the messages. It can be easy to
forget what folder you are in because the main portion of the window where the
messages are displayed looks the same.
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Outpost Packet Messape Manacar
Ot Setup Tools Actions Help
New| open| Delete| print]
Folder L.
" : i U [ Type [ From [To [ BBS | Subject [ Date/Tive |
i B AABWK  ALL K6FB-2  BMHA Bicycle Mabile Hams of __ 11/28/9518:_. 399
- - B AABWK  ALL K6FB-2  Net Preamble 03/18/93 2 3660
B AAGWK  ALL KEFB-2  >>> how 10 use the node and/or  03/18/93 2 26
Ol Tray B AABWK AL KEFB-Z  Welcome 03/18/93 21.20 1035
B KNBPE  ALLUSR KBFB-2  Cuperlino ARES/RACES 11/04/06 17-... 246
B BABWK AL KEFE-2  KEFB websile, breaklas!, net 11/04/05 1853 261
B KEGBBCW  ALL KEFE-2  Packet Tutorial UL 05/31/00 1326 17
Sent B GNCEOC  SCCEOC  WEXSC  SNCEOC operafional 07/22/06 1452 363
Msgs B SNCEOC SCCEOC  WEXSC  dil01-2106 01/21/07 1606 467
B SHYEOC ALLEDC  WEXSC1  Request to submi 2005 SET data 10/17/06 2348 1836
CUPEOC LOSED.. WEBXSC-1 Welcome to outpost 03/20/07 14 321
B LOSEOC AL WENSC] TestBulletin from Las Altos Q3720007 14:21 243
Diaft
Msas
Deleted
Msgs
12 hems, 20 Totel | Station 1D NEIAC - Tacties! Cal: LOSEAT - THE: KPE:3 - BES: WEKSC [anonon 1s17s1
£
$
¢
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The top buttons are actions that you can take at any time. For example, you can
create a new message by clicking on the “New” button.



A Closer Look

Outpost Packet Message Manas~r

| Subject | Date/Time [ sie|
EWK BMHA Bicycle Mobile Hams of _ 11/28/95 18... 393
B AABWK  ALL K6FB-2  Net Preamble 03/18/9321: . 3660
B AAGWK  ALL KEFB-2  >>> how 10 use the node and/or  03/18/9321:... 846
Ol Tray B AABWK AL KEFB-Z  Welcome 03/18/93 21.20 1035
B KNBPE  ALLUSR KBFB-2  Cuperlino ARES/RACES 11/04/06 17-... 246
B BABWK AL KEFE2  KEFE website, breakfast, net 11/04/05 18:53 261
B KEGBBCW  ALL KEFE-2  Packet Tutorial UL 05/31/00 1326 17
Sent B GNCEOC  SCCEOC  WEXSC  SNCEOC operafional 07/22/06 14:52 363
Msgs B SNCEOC SCCEOC  WEXSC  dil01-2106 01721407 16:06 467
B SHYEOC ALLEDC  WEXSC1  Request to submi 2005 SET data 10/17/06 2348 1836
CUPEOC LOSED.. WEBXSC-1 Welcome to outpost 03/20/07 14 321
Archive LOSEOC WENSC] TestBulletin from Las Altos Q3720007 14:21

12 Items, 20 Total iStatlnr\\D NBJAC - Tactical Call LOSEOC ~ TNC: KPC-3 - BBS: WEXSCA

|00:00:00 131751 |
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The big window displays the messages in this folder. New messages are in bold.
Urgent messages will be listed in red. Bulletins are indicated by the “B” in the
“type” field.




ALLEDE
ALL

N CARES EiF-2 N
C CUPED.. WX
NEWUSH  REFEZ

Message viewing

. Supports viewing, -loi x|
. . . File Edit Actions Help
prln.tlng’ deletlng or Prlntl Reply Forward Delete Close Expire
saving a message to a R Tm—
local file Bhs, KGFB-2 Sent; 12/21/04 11:41
Fram: KNEPE
. Reply and Forward To GARES
message formatting S T s
MSG#43 12/21/04 11:41 FROM KN6PE TO CARES ;I

A liems, ¥ Tata | SUBJECT: N95 Mask Purchase
PATH: K6FB

B11 Packet-enabled CERES members,

Those CARES members interested in purchasing N95 masks as described by
Marsha, please let me know. We will be doing a bulk purchase at a cost of 51

1. Highlight Message e ot e
2. Press “Open” ol
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To read a message, simply highlight the message and click on “open”. You can also
double-click on the message to open it. Notice that when the message is opened,
“Bulletin Message” is displayed in the yellow bar if this is a bulletin.



Features .

Fle Ede Sebp Tock Adtiond Help

o ope| Gl pora| _ saoiscenn]

STEOP
HEVFH L

Deleting Messages

. Moves message to the
Deleted Messages folder
(just like a trash can)

I KNG

" WELEOC
ENEFE
KNEPE

KNGE  NEWUSR  KEFZ  WHATS NEWI Mesagedn. Hons 145

How?

1. nghllght Message | Sitema, 35 Totat [ Station D: KNEPE - THC: KPC3 - BB KEB2 [ooouon [15ma
2. Press “Delete”
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Deleting a message is just about as easy — highlight the message and click on
“delete.” Where do deleted messages go? To the “Deleted Messasges” folder. They
are not removed from the system until you delete them from the “deleted messages”
folder.



Features

*Creating Messages
* Direct Entry
* Cut-and-paste from other apps
* Import Text from a file
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There are three ways to create a message to send. They are listed on this slide.
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Workflow — How it Gets Done

Press “New” to create a new message
Compose the message.
Press “Send” —message is moved to Out Tray

A

Press “Send/Receive” to transmit/receive msgs

1. Sent messages are moved from Out Tray to Sent Msgs folder

2. New messages are displayed in bold in In Tray

Read and handle new messages

o

Delete messages as needed

1. Deleted messages moved to Deleted Messages folder

22 Outpost Packet Message Manager 2.1.2 - ‘ t.’
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But before we talk about how to create a message and send it, it is important for us
to understand how things happen.

The key here is that messages aren’t really sent until you click on the
“Send/Receive” button. (Note that there is an option in Outpost to send the message
as soon as it is written, although it is not recommended to select this option.)
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How it Gets Done

1. Click...

2. Type msg...

3. Click...

[Message stored in Out Tray]|

4. Click...|_Send/Receive |\)=/

[Message moved to Sent Msgs|
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This demonstrates the workflow graphically.
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Features

Message creation

. Supports Private,
Bulletin, and NTS
message types

. Message formatting
before sending

. Set messages to
Urgent

. Request delivery or

|
read receipts
How? I
1.  Press “New” &
2. Type Message L.

3. Press “Send”

!
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Now, to create and type a message from scratch, simply click on “send” and type in

the information. If you are in Santa Clara County, not that we use tactical call signs.

There are options to set message urgency to urgent. Setting a message to urgent
does not change how a message is handled. For example, urgent message are not
transmitted first. They are only flagged as urgent on the other end (they are
displayed in red)

There are also options to request receive receipt and read receipt. Note that these
increase the amount of network traffic. Use these options with care.
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Direct entry

« Allows cursor placement
within the text field

» Supports TAB characters

[ |

Creating Messages

File Edt Actions Help

prit|  send|  save|  ciose] E‘ Pt | Bul | TS

Private Message; Delivary Recsipt Requestsd

Bbs: |WBKXSC-1

Fram: |CUPEOC

To: [XSCEOC
Subject: |Status of Cuperting EOC

. The following operating positions are staffing at the EOC: =]
(cntl-tab) thereby reducing
Director Emergency Services Dave Enapp 777-1234
Character count Flanning/Intel Section Bob Enight 77-2345
Logistics Section Ken Suith 777-3456
. : perations Section Bill Uright  777-4567
» Allows text files to be directly Finanse Section Tewty Colling 7775678
Imported into the message A1l phone mumhers are in the 408 area code.
form 1m0 musEE
T
-]

!
25 Outpost Packet Message Manager 2.1.2 ”‘ \L’

When entering text directly, you can format the message using the tab key. This is
recommended over using the space bar. The tab key represents only one character
instead of multiple spaces. This cuts down on the amount of time it takes to transmit
a message.

25



Creating
Messages

Cut-and-Paste from
other apps

» From Excel, highlight the
fields to be copied, then
paste into an Outpost
message.

» At the receiving station,
highlight and copy the
message, then paste back
into Excel.

» Tabs are preserved so the
message can be pasted
back into another
spreadsheet.

E Microsoft Excel - Shelter Requirements.xls

|G Fle Edit Wew Insert Formast Tools Dats Window Help

Do SRy drBBY v (&= s 4 E e

| v -0-BrUSE=E=E 8%, WaEE -
Al | =| tern Nurrber
A | B [ ¢ [b] E [ F [ @
Item Num Description On Hand Units Qty needed Req Date Req Time

1 cots 30 ea 25 18-Mar 18:00)
2 blankets 45 ea 15 18-Mar 18:00]
3 water, 12 0z bottles 200 bottles 100 19-War 12:00
4 First Aid kits 3 kits 12 ASAP
5 Toilet paper a0 rolls 250 19-Mar 12:00
B tooth brushes 10 ea 50 ASAP

e oy

Ein Edt fictiors Help

Pt seed| S| closal g | P | TS|

Urgark. Pireate Message
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HSCEOC

EhiBer Maderial Requinsmends

Please send the following saterial to out shelter: &
Item Nusber Description Un Hand Units 0Ly needed Req bate
Req Time
1 cots 30 ea 25 1u-Nar L0300
2 Blanket 45 e 15 18-Mar  18:00
3 water, 12 of bottles 200 Bottles 100 15-mer  12:00
4 Fiest Aid kits 3 kit 12 ASAP
sl Toilet papes 50 colls 250 19-Mar 12:00
6 Eooth brushes 10 ea 50 ASAF
7 eooth paace s en 58 ASAP
v note pads 0 es as 19-Mar  10:00
5 pencila 0 ea 25 19-Har  18:00
] wE 0 00 1o-Nar  10:00
=
1( £ 3
X

You can cut-and-paste from other applications such as Excel. When received on the

other end, the user can then cut-and-paste back into Excel.
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BRI New Packet Message: _1ol x|
Fle Edt Actions Help

Creating Messages ﬁk_l Bl e

Open 2 Report

Import text from a file
» Open a new message

* File > Open afile

» Select the text file, press

OK
* Full in the Destination and
Subject BEnew Packet Message g

Fil: Edt Actions Help

* Press Send when done. __rm| s sws|  cee| | P eyfnrs]
Private Message

Bbs: [KNBPE-1

From: |KINGFE ¥
To

Subiect: [NG5 Maskbd

lALL Packet-enabled CARES members, =

IThose CARES members intere: in purchasing N85 masks as described

by Marsha, please let me know. We will be doing & bulk purchase at

2 cost of §1 per mask for CARES members. I

regards,

[Jim KNSPE

\ \ Y
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The third option is the ability to read in the contents of a text file. This is the
method that will be used to transmit what are know as PacFORMS.

To read in a text file, first select “new” to create a new message. Once the new
message window is open, click on “File->open...” and point to the text file you
want to use. The contents of the text file are then copied into the body of the
message.



PacFORMS

What Are They?

Browser-based versions of

» City Scan/Flash Report

* Logistics Request Form

* RIMS Form (called PacRIMS)

* DOC9 form (for hospital support)

Requires Javascript to be enabled in the browser

Read and follow the red instructions

28 Outpost Packet Message Manager 2.1.2 = i t’
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And while we are talking about PacFORMS, what are they?

These are browser-based forms that have been designed to look just like their paper
cousins. The operator types theinformation from the printed sheet into the
electronic form and then sends it to its destination.

The key to using the PacFORMS is to follow the instructions in red. If you don’t,
you may miss a key step.
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"CITY SCAN" - FLASH REPORT

JawaSierigt Visssion for Packe Transmissisn
Mota: This Foren has bagn sdaptad fram the papar fom 1o prapars an ASCI (2t fis s ranamission va Amateur Radio Packet
Fomn adapted by Phil Henderson, KFEZS0, Meurtain View, CA AEC
W 21, 120806

{This farm is basst wsed with MicrosoRt intamat Explorer)

« Harms in RED are requred »
fa. | Los Alios > 1) H Oitven s sedectod. Enter Enginy Namn:
DateTime of Contact 2. Date: (0372172007 3Tima (Hiblin - 24 Hossr Timay (1340
Contact Pergon 4.) Mgy, [Bob Lacey 5 Tilly; Chisd of Folice
Meethod of Contact: 6. Prone # BO0-555-1212 1. Rade Fraquency: 14557
B.) HAS THE CITY BEEN IMPACTED? (check ana) Sves ] ]
9) HAS A LOCAL EMERGENCY BEEN DECLARED? (chack one) @ves Ona
When? 0. Date: 324007 1) Tima (Hidin - 24 Hour Time). 0830
Who signed 7 12 Naenp: e 13, Titte: [Chist
14.) HAS YOUR EMERGENCY OPERATIONS CENTER BEEN ACTIVTED? (check and) @YES Onp

15,0 Can you all me what MAJOR INCIDENTS are sccurring now? (chock one)
@ves Cino

16.) Please Summarize INCIDENT, LOCATON and STATUS in the best aroas below

INCIDENT Max 80 chas.} LOCATICON fMax 6 chrs) STATUS (Max 60 chis.)
Dauntow ate Danches Eain SEreet Brnches make cififens' bottoms
1. soTe, Citizens revolting,

1ih,
Tie
i, bl il ol L
(o = 7 o
N
¢
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This is an example of the flash report that the county will request from each city on
a periodic basis.



% ) City Scan Flash Report - Mozilla Firefox (= 2= il il

e & vew Hgoy fockmaks fook bk

B} = . @ @ = K 5 ©yes  Owno
Home frne 1

a4 = [ Forms = 88 mages = (D) Irfoemation = 5 Miscebareous = o Cutine = & & Resize = o Tool @yes  Owo

r bod ES L
sep
15 .
YES (o]3)

16
. chisj STATUS (Max 60 chrs.}
. {:s:o! X Benches make citizens' bottoms
i [Dab Lacey) sore. Citizens revelting,

163 £ of Police] § v

: [800-555-1212]

SuBMiT]] [ ClearForm

'\'
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After you have completed the forms, follow the instructions in red at the bottom o
the screen, which say to press the “Submit” button. Once this is done, another
window is displayed showing all of the text that you have entered (see inset).
Again, follow the instructions in red and save the input to a file. Remember the
name and location of the file. Hint: make the file name meaningful. You could

include a timestamp in the name so you have an idea of when | was transmitted.

30



:wPa(kEt Messa: =lolx|
Creating Messages — mommme = =l
BT
r = emem
- P . j
Import text from a file e
» Open a new message )
* File > Open a file
» Select the text file, press | | =l
OK —’— JE2 O | =
[ el =]

Full in the Destination and
Subject BEnew Packet Message ol

Fil: Edt Actions Help

Press Send when done. et se| see| | cos|  ur| Pa|myjums]
Private Message

Bbs: [KNBPE-1
From: |KINGFE ¥

To
Subiect: [NG5 Maskbd

A1l Packet-enabled CARES members, =l
Those CARES members interested in purchasing NS5 masks as described

=
by Marsha, please let me knov. We will be doing & bulk purchase at
2 cost of §1 per mask for CARES members. I

regards,
Jim  KNGPE

\ L
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After you have saved your file from the Pac FORMS, open a new message in
Outpost and click “file -> open...”. Browse to your file and click on OK to read
the contents of the file into the body of the new message.



Special Message Handling

Bulletins =k
File Edit Actions Help
» To create, click on “bulletin” : T
when writing message.
. Bbs: KNGPE-1 Sent: 02/11/0614:33
* To delete a bulletin off of the Fom: KNGPE |
BBS To: CARES
that you originated... S (T =
. . ot /1108 JasssiaL B Do you want to delets this Bulletin off of the BBS? |
*Retrieve the bulletin from the BBS [T Tritt Resutss A e O ke Dot et o
.Open the message e — the BBS (will occur during the next BES connect).
*Press EXpiI’e e will having a debrief of L‘E‘I L.
Please plan on attending
»On the next send/receive session,

73, Jim KNEEFE
the bulletin will be deleted off of  [ec. cupertine ares/races
the BBS.

Notes

* You can only delete bulletins
that you create
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Bulletins are special types of messages. These are received by every station in the

county. Send bulletins with care — they can take up a lot of bandwidth since
each city has to download the message.

Bulletins are stored on the BBS until you delete them. To delete the message, click

on the “Expire” button. The bulletin will be deleted the next time you do a
send/receive cycle.



’ Initialize the Interface ‘

A Typical Session :

’ Connect to the BBS ‘

!

’Process Bull, NTS deletes‘

B utpost TNC Message Manager — ol x|
Fle Edi Setup Took Actions Help

Hew | Open| nolete| ((sercliRersive] l
Send all messages
FokierList from Out Tray
Jsion

InTray

] ERNEPE | LISERS (1371 12-39 [}
B FNEPE LSERS KMEPE-1 Wi 03/06/04 12:33 2880 i i
B KNEPE  LISERS KMEPF-1_Def cted indg 111 13/14/04 156N pal ’ If Private is set
ey BB T~C Session Manager =iojpd.
Abort Session
Sent
Msgs ECHO was ON |
cod:my KNEPE
cud:Mon off Read
(i MONITOR was OFF
cud: daytine 040220105032 I
Dt cud: connect KeFE-2
M cud: ##% CONNECTED to K&FB-2
[KPC3-5.1-HM3] n't
91200 BYTES AVAILAELE P
e THERE ARE 13 MESSAGES NUMBERED 24-675
Welcome to the LCARC packet mailbox.
3liems, 5 Tolal | Station|D: KNEPE - THE: kpr3 [ENTER COMIRND: B, J,K,L/R,3, or Help >
LM ge
=| Eipts
¥ Always show this window duing a Send/Receive session
‘F\elﬂswngMessageL\sl. ‘UUUUULi face
T
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When you click on send/receive, Outpost by default will open a window and show
you the commands that it is using to process your messages. You can turn this
window off if you don’t like to see the details. But just for a second, watch to see
how much work Outpost does for us, making our job that much easier!



For more information

Send inquiries to...
Jim Oberhofer, kn6pe@arrl.net

Visit the Outpost website...
http://www.CupertinoARES.org/projects/outpost

Or, Google... outpost packet
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For more info, call...
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Questions?

S

Your turn...
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